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SPH 140 – Videoconferencing Facility (new 12/2005)
Locations:
NEAR SITE:

Shippen (SPH) 140 – Shippensburg University

FAR SITE:

Dependent on program location

Sony Camera (front camera)

ParkerVision CameraMan (rear camera)

Samsung 50" Plasma Display (front monitor)

Samsung 50" Plasma Display (rear monitor)

Smart L-250 Interactive Lectern

Close-up of Smart Sympodium Interactive Display
unit attached to lectern.
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AMX

DVD/VCR Combo Player
LCD Projector (ceiling mounted)

Not Shown

Wireless Keyboard (integrated mouse track ball &
mouse buttons)
If the keyboard does not seem to function,
make sure the keyboard has a clear line of
sight with the RF receiver.
Wireless Lapel Microphone or Wireless Tracking
Microphone [use only one device]

OR
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TO BEGIN SESSION…

Step 1: Unlock Lectern's three doors.

Step 2: Push button on Tower CPU to turn on Computer

―On‖ button

(2) USB Ports

Step 3: Push button on Smart Sympodium to turn on Interactive Display
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Step 4: Push large black button at lower center of Wireless AMX Controller
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Step 5: The Entry Screen appears. Press the ―Video Conference‖ button.

Please wait approximately 20 - 120 seconds for the equipment to initialize. You will see the Polycom
logo and hear dramatic music.

Step 6: Make a Call

1.
2.
3.
4.

Dial far site: Click on "Video Call Control" button on AMX
Press "Address Book" button
Scroll down list using the "Arrow" buttons to select far site location > Press "Enter" button
Press the ―Call‖ button. You will see the far site in the "Rear Plasma".

Step 7: Tracking Microphone
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IMPORTANT: Put the wireless "Tracking Microphone" strap around your neck. Make sure the
receiver is located in the front and is right side up. (NOTE: If you hold your notes, your hands or a
book, etc. in front of the receiver the camera will not track properly.) Press the ―Rear Cam‖ button.
Press one of the ―Tracking‖ buttons to initiate the tracking signal between the camera and the
microphone.

Arrow controls – allow you to move
position of the camera.
Zoom – move the focus of the
camera closer or farther away.
Set [Tight / Wide] – 2 presets that
allow you to quickly toggle between
a tight and wide camera shot.
[Normally set to WIDE]
Tracking Presets – 4 presets that
allow you to move the camera in
close [tight], farther away [wide],
Front [View of the podium], Left [left
side of the classroom].

1.
2.
3.

4.

Rear Plasma

LR

Rear
Camera

RR

LCD

LF

RF

Projector

Instructor Interactive Lectern
Sympodium

Front Plasma
AMX

Projector Screen

Front Camera
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Step 8: Toggling Between Devices

Use the buttons on the top of the screen to move between devices. Be aware that there is
approximately a 15 – 20 second delay when switching between devices.

Choose a device. The center portion of the screen will show the device options.

1. Arrow controls – allow you to
move position of the camera.
2. Near / Far – allows you to
control cameras on the nearor far-side if the we are
allowed to have access to the
camera controls.
3. Zoom – move the focus of the
camera closer or farther
away.
4. Set [Option Buttons listed
below]
Wide – show a wide camera
angle
Front Left / Front Right /
Rear Left / Rear Right -
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1. Arrow controls – allow you to
move position of the camera.
2. Near / Far – allows you to
control cameras on the nearor far-side if the we are
allowed to have access to the
camera controls.
3. Zoom – move the focus of the
camera closer or farther
away.
4. Set [Tight / Wide] – 2 presets
that allow you to quickly
toggle between a tight and
wide camera shot.
5. Tracking Presets – 4 presets
that allow you to move the
camera in close [tight], farther
away [wide], Front [View of
the podium], Left [left side of
the classroom].
1. DVD / VCR – allows you to
choose the desired device.
2. Arrow Keys – Allow you to
move between menu items.
3. Menu / Enter – The menu
button displays the menu. Use
the arrow keys and then the
enter key to choose options.
4. VCR / DVD controls – use the
controls to play, stop, pause,
fast forward and reverse the
VCR / DVD.

AFTER SESSION CONCLUDES…
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Step 1: Disconnect call to Far Site. Press the ―Hang Up‖ button.

Step 2: Remove "Tracking Microphone" & reattach to Charging Unit.

Step 3: Shut Down Computer > Turn off Sympodium
Step 4: Close and lock cabinet.
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An Introduction To Videoconferencing
for Instruction and Learning
Section 2 of this training manual will discuss the following topics:
• An Introduction to Videoconferencing for Instruction and Learning
• The Global Education Environment
• An Historical Perspective on Distance Education

An Introduction to Videoconferencing for Instruction and Learning
Benefits

W

ith videoconferencing, it is possible for individuals and groups in
different locations to meet and interact face-to-face in real time.
It is the best of both worlds allowing the student and professor to
interact online as well as in the classroom. Videoconferencing

enables us to function as much more than "talking heads." It makes possible
the interactive use of documents, objects, and data on computers, fax, VCR
tapes, slides and transparencies in real time. All of the audiovisual equipment
you have used throughout your teaching career is at your fingertips.

The key characteristic of videoconferencing is that communication among
faculty and students occurs simultaneously, in real time, at distant sites. In
other words, videoconferencing augments the traditional classroom. It enables
you to overcome barriers such as time and distance that limit access to quality
education and allows for immediate feedback to questions or concerns. It
increases access for students and promotes institutional growth, stability, and
survival.
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The quality of teaching and learning in videoconference classrooms can be as
effective as that in traditional learning environments because videoconferencing
makes possible new and interesting educational opportunities. For example, the
intellectual and research resources at your institution can be brought
seamlessly to other sites and your students can have access to classes and
scholars not available at your institution.

With videoconferencing, faculty can use the most powerful aspects of the
interpersonal dynamic while taking advantage of interactive multimedia
possibilities regardless of distance. Videoconferencing is far more than merely
a "television" version of the lecture.

Most institutions begin using videoconferencing to deliver an existing curriculum
to more students, perhaps more economically, in a way that is not
geographically restricted. But there can and should be much more to
videoconferencing than this.

The information world is expanding so rapidly that no educational institution can
contain or teach all that is to be learned. Students can now tap into a
knowledge base that is not constrained by your home institution's geographic
location.

The modern communication media facilitate, and student expectations
necessitate, a new individualized, customized, and interactive distance teaching
and learning paradigm. In order to make effective use of the new media,
administrative and faculty creativity will have to be directed to expanding
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pedagogical opportunities. It is much more than the same old wine in new
bottles.

Teacher Centered

Learner Centered

Paradigm Shift

Remember: What is important is not the technology, but what it can
support and enable you to do to achieve your strategic goals in this new
educational environment.

Partnering, resource-sharing, and agile, networked relationships are the basis
for achieving your goals. The emphasis is on establishing human connections.
Technology is only a means to do so.

Challenges
Videoconferencing also has it challenges. Instructors need to be aware of the
technological capabilities of the equipment in the classroom. Understanding their
capabilities helps you have a realistic view of what will happen in your classroom.
When working with equipment there are always technical issues that have to be
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overcome, whether there is a storm causing power fluctuations or a problem
with the communication between facilities, the instructor along with graduate
assistant needs to be flexible and have a contingency plan in place. Sometimes
communication between the facilities can be awkward. Remember to include
the other students at the other facility by calling by name and asking questions.
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Here are just a few examples of the kinds of relationships that
videoconferencing can support.

Access
Administrative Functions

Advanced Placement
Courses for high
school students
Dual enrollment
Satellite campuses
Diverse learning
groups
Special populations
International
opportunities

Board Meetings
Legislative updates
Faculty Meetings
Resource sharing
Program and course
management
Staff development

Community relations
Family and
literacy programs
GED classes
Job and
employment
training
Community
education
courses
College credit
courses

Videoconferencing
Supports

Collaboration
Collaborative Teaching
Mentoring
Team Learning Project
Joint Program
Development
Scholarly research and
development
Colloquia and meeting
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Curricular
enhancement
Specialty
subjects
Experts and
mentors
Research labs
and centers
Virtual field trips
to libraries and
museums
Expanded
learning groups
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Hands-on Activity

Pull a card from your wallet or pocket
Place your card on the document camera
Tell us a little bit about yourself—
What’s your nickname?
What’s your hobby?
Remember to engage the far-side. Look into the back
camera.
Select the computer.
Open a browser – Surf for a link about your hobby.
Using the front camera take a poll of your class. How many people
share your hobby?
Select the Computer. Using the Smart Notebook software? Ask the
class the question that appears on the screen. Fill in the graph using
your pen
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Best Practices
TEACHING IN THE VIDEOCONFERENCE ENVIRONMENT
Curricular and Instructional Strategies for Interactive Videoconferencing

I

nstructional design is a very important part of teaching effectively using
interactive videoconferencing. Instructional design for videoconferencing
focuses on specifying instructional goals and strategies and also on

planning activities that encourage interaction between professor and students,
students and students, and students and the course material.

This training session and this manual are not intended to substitute for a
course in instructional design. Please consult with the members of the
Instructional Design and Development Services department for more
information.

We will focus, instead, on the things that need to be considered when using
technologically mediated instruction such as videoconferencing. It is important to
stress that there is more to it than adapting what you currently do in a traditional
classroom.

Teaching via videoconference opens up options that are not possible in the
traditional classroom. For example, most colleges do not have the resources to
bring the world expert in a field or the author of the text you assign to your class for
a live discussion with your students. Videoconferencing enables you to do that and
much more. It is up to you to make strategic decisions about how to strengthen
your teaching and your students' learning by using the technologies now available
to you.
This Section includes suggestions for planning and preparing to teach your
videoconference course, including the following topics:
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• Adapting Teaching Techniques
• Planning a Lesson for Interactive Video
• Delivery Techniques
• Camera Presence
• Stimulating Interaction
• Questioning Strategies
• Interactive Teaching Techniques
• Classroom Management Tools
• A Checklist for Preparing to Teach a Quality Videoconference Course
• A Sample Student Welcome Letter
Adapting Teaching Techniques
Most of the teaching techniques you already use can be used in the
videoconference classroom. You can use the following chart to think through the
various options and their potential adaptations to the video medium.

18

Video Conferencing Manual

Teaching Mode Comparison Chart

Teaching Mode

Conventional Class
Environment

Can Still Do in
Videoconference
Environment

New Options in the
Videoconference
Environment

Lecture

Q&A

Discussion &
Dialogue

Case Studies

Group Work

Role Playing

Team Teaching

Expert Guests

Demonstrations

Multimedia

Other
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Planning a Lesson for Interactive Video

Videoconferencing is most effective when various presentation media are
used. You can mix videotape, PowerPoint, three-dimensional displays from
the document camera and SmartBoard ™ notations, with live views of the
professor and the students. Flowing from one medium to another to get your
message across maximizes the potential of videoconferencing.

What is different in videoconferencing is that distance changes the
presentation dynamics. You need to pay attention to the transitions from
one element to another. Doing so will make your class operate more
smoothly so that the students are not distracted.

Videoconferencing also requires more preparation time, especially in the
beginning. You will need to structure your presentation in order to use the
technologies to your advantage. Breaking your presentation into short
segments is particularly important, especially if you are lecturing.
For any class, the basic elements of instructional design must prevail —
what do you want your students to learn and how are you going to facilitate
that process?

The following section describes a simple five-step planning process to assist
you as you develop lessons to be taught using the medium of
videoconferencing.
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Five Step Planning Process
1. Learner Outcomes

What do you expect your students to
accomplish?

2. Strategies and Activities

How will you convey the topic (Lecture
discussion, handout, etc.)?

3. Media Selection and Cues What audiovisual aid will you use to support
your instructions? Have you planned to cue
them in
Document Camera
Audio Clip
Video Clip
Slides
Documents on PC
PowerPoint Presentation
Internet
SmartBoard
4. Handouts and Materials

Have you made arrangements to distribute
handouts to students at all sites?

5. Time

How will you allocate time during the course
period?
Introduction
Content Delivery
Information Sharing
Hand-outs on activities
Discussion
Demonstration
Student interaction
Q&A
Student Presentation
Evaluation
Feedback
Assignments
Advising
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Delivery Techniques
Orient your students to the classroom equipment, procedures and protocol
at the beginning of the first session and repeatedly throughout the first week
or so. Assure them that they are not on "television" and that they can only
be seen by the people at the other site(s). And remember, this is not
broadcast television. This is a classroom. Moreover, the home site and
remote site(s) constitute one single class, not multiple classes electronically
looking in on each other.

Articulate your expectations for the class on the very first day and
emphasize that you intend to focus on creating interaction. Specify in your
written syllabus the "etiquette" you intend to use throughout the semester.

Instruct students on classroom protocol:
mute any open microphones when not speaking
don't wad papers or tap pencils near an open microphone
speak directly into the microphone
be aware of a slight audio delay, and demonstrate this for the
students
establish procedures on pagers, cellular phones, and laptop
keyboard sounds
speak up or hold up a book, a flag, or a hand if you want to make a
comment
request that students remain in the same seat throughout the course
as necessary, allow students to move around to optimize their field of
vision (but recognize that this might have an effect on grouping
students for camera pre-sets)
assign students to rotate as classroom facilitators
move and gesture slowly and smoothly
This list, of course, is not exhaustive. See sample letter to students at the
end of this chapter.

Use verbal transitions to help the students maintain continuity. Explain
what's happening as you move through your presentation. Say, "I'm going
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to switch to a videotape segment now" or "please look at the slide" as you
move to a new element. This helps the students stay focused.
Students learn well when information is organized into smaller pieces,
so break your presentation into shorter segments. Segmenting also
facilitates interaction with the audience.

Think through the basic elements of learning: Students will watch, listen, write,
question, participate, present. How can you use available media to facilitate these
activities? Determine length and sequence of activities based on your teaching
style.
Camera Presence
As a reminder, there are a few things you should be aware of when teaching
in the videoconferencing room:
Colors:
Choose the color of your clothing carefully. Avoid reds, hot pinks and
electric blues. Regular blues and bluer shades of green work well. Avoid
high contrast stripes, plaids, and complex patterns, even on ties or
jackets. No contrasts such as unbroken navy blue or black should also
be avoided. Professors with darker complexions should avoid white or
bright colors.
Jewelry:
Less is more. Do not wear jewelry that dangles or makes clinking noises.
Make-up:
It is not necessary to change anything you do currently. This is not
broadcast television, and you are not expected to behave or look
like actors.
Eyeglasses:
Be aware that lighting might cause glare. Check this on the monitor.
Voice:
Practice natural vocal delivery. Conversational pitch is optimal; it is not
necessary to move up to the microphone. At some transmission speeds
there is a slight audio delay. If that is the case, speak slowly until you
become used to the delay.
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Movement:
Move and gesture slowly and smoothly
Just as in your regular classroom, nonverbal interaction is a key element for
engaging students. Make eye contact with the video camera and use close-up
camera shots when you convey important ideas. Use appropriate and normal
gestures.
Vary the pitch of your voice and your facial expressions to avoid being a
"talking head." Speak clearly and maintain a moderate speaking pace so
students at the remote site can understand you.

Practice various camera angles as well as alternative modes of presentation.
Videotape yourself, view the tape in the privacy of your home, critique your
presentation, and make changes as appropriate. Remember that you are
welcome to connect to the IDDS office to try out your presentation with the
IDDS staff.
Stimulating Interaction

The instructor must make every effort to stimulate classroom interaction.
The day of the dry lecture with no interaction is over.
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Student-teacher connection is more important than physical proximity.
One technique that is particularly effective in stimulating interaction is to
place the desks in a semi-circle at both the home and remote site(s). Thus
each site is looking at the other site(s) looking back at them. Such an
arrangement creates an opportunity for dialogue by sharing visual, oral, and
emotional, if not physical, space.

Using the technique of the semi-circle, the professor moves from behind the
lectern to the "center" of the room and teaches "in the round" by turning
from the camera to the home site and being "part of the picture" at both
sites.

Encouraging Interaction
Here are some suggestions that can be used in a videoconference
classroom to encourage and motivate student interaction.
Initiate interaction with students at the remote site within the first five
minutes so that the students don't fall into a pattern of passive
observation.
Integrate interaction with activities or assignments prepared in
advance.
Use the tools at hand - document camera, slides, VCR, whiteboard,
multiple camera pre-sets - to increase your ability to provoke and
stimulate student interest, attention, and interaction.
Invite all to participate. Assign responsibilities to specific students in
advance.
Increase student-to-student dialogue and interaction as well as
student-to-professor dialogue.
Wait time is important. Remember that there is a slight audio delay.
Allow a short silence while you await a response.
Clearly define discussion topics and possibly assign them in advance.
Use written assignments, case studies, or quizzes as a starting point
for a discussion.
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Do group work on camera.
Have students use the equipment for individual presentations or
panel discussions.
Use supplemental services for the exchange of ideas - e-mail, fax, phone,
WWW, chat rooms, and bulletin boards.
Vary the timing of interactive segments.
Vary interactive activities.
And finally, hold students as accountable for learning protocols as
they would be in any class. They must prepare, pay attention, ask
questions, take notes, participate, study, and do work on time.
Questioning Strategies
Here are some suggestions for maximizing questioning and interacting in a
videoconference class:
Protocol: Establish the ground rules for questions during the
first class. Some faculty have found that a "question sign" is an
eye-catcher.
Personalization: Assign seats and familiarize yourself with the
class roster. Use the names of students at the local and remote
site(s) when asking a question.
Team Activities: Assigning colors to groups at each site is a useful
strategy during a cooperative learning activity (for example, "the blue
team will report next on their discussions").
Group Participation: Ask a student by name to survey his or her
group for questions.
Auditory/Visual Learning: Ask questions that appear in writing
on the screen to enable students to both see and hear the
questions.
Focus: Ask one question at a time.
Classroom Management Tools
Make a master roster and seating chart; use it for the first several
sessions or for guest speakers. Since it is difficult to see individuals
in a group shot, the seating chart may also be helpful for students to
learn names of those at the remote site. Some professors have had
the students on the far-side create large name tags to help them
recall student’s names.
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Use names. It is a basic instructor skill, but it is particularly important
at a distance.
Be yourself. Come across the way you do in a face-to-face situation.
Open with an informal roll call. Use it as an occasion to get
students from the remote site talking to the originating site.
Look at the camera. Make eye contact with the camera lens.
This will appear to students at the remote site as direct eye
contact with you.
Plan a videoconference technology orientation during the first class
meeting. If you are new at this, admit it and relax.
Remember not to do anything for the local site that you are not able
to do for the remote site (for example, passing out a paper at the last
minute without immediate plans to fax, e-mail, or post it on a web site
for the students at the remote site).

Back-up Plans

A fax machine is available in the Media Services office. Your graduate
assistant will have access to the office. This will enable you to send
materials to remote sites in emergency or last-minute situations.
The speaker phone, usually located on top of the cabinet that holds the
AMX device near the podium, can be used in the event that the audio
portion of the videoconference is not working.
A technical support person is available at each remote site; the graduate
student at the far-side is usually hired by the MBA program while with
student at Shippensburg is a Distance Ed funded student. Please go over
the day's lesson briefly with these tech support people so that they can
continue with any graphic materials in the event of your video absence.
Send materials ahead. Should the videoconference go down, your students
at the remote site will still be able to see graphics or notes on their own
document camera.
On those days when you have scheduled a videotape presentation, always
request that a copy be available in the remote classroom as well. Should
there be a system problem, all sets of students will still be able to see the
videotape.
A phone list of technical support people for all sites involved is available on
the bulletin board behind the podium.
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A phone list for bridge and video connection numbers is available
on the AMX unit in the videoconference room in case the
conference goes down.
Discuss protocols for possible system interruptions with students in advance
of such an occurrence.
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Tips for Videoconferencing
Near-Side
Although the Professor is in your classroom your classmates cannot hear
you unless you press the microphone to speak. Please remember to press
the microphone even if you are only telling a joke. The students on the farside may find what you have to say both relevant and amusing.

If you are presenting please have all your disks and documents ready at the
beginning of class. The technician can then load your presentation on the
laptop before class begins limiting class interruption. Please also inform the
technician if you will need to use the document camera, or Sympodium. The
technician can instruct you in its use before class.

Remember to address the Professor, your class and the class at the far-side.
Try to look directly at the camera to make ―eye contact‖ with your other
classmates.

Remember when speaking to look at the back camera to address the class
on the far-side. Also, specifically ask if the far-side has any questions about
your presentation.

It is worth repeating. Hold down the microphone when you are speaking.

Far-Side
If you are having trouble hearing the Professor, seeing the information on
the screen or if the system is making an annoying sound, TELL your
Professor DURING class. The technicians cannot attempt to fix the problem
without first knowing that there is a problem.
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The camera on the far-side has a limited side view. Please try and sit in the
center of the room rather on the sides. Your Professors and classmates
would like to see you.

When speaking, make sure you hold your microphone down for a few seconds
before speaking and then for the entire time you are speaking. When you hold
and let go of the microphone frequently the camera zooms in and out and the
classroom at the Shippensburg campus does not hear all of your comments.

Alternately, don’t be afraid to ask about something you missed during class
because someone did not hold their microphone down when they were
speaking.

Your class is being recorded so that you can review it. You will find that the
technician will switch back and forth between the instructor/class and the
document that is presented via the document camera or computer. The
recorder can only pick up one type of input. In order to record both the
Professor and the document, the technician must switch between them. The
technician knows that you can see both the Professor and the document at
the same time.

If you are presenting please have all your disks and documents ready at the
beginning of class. The technician can then load your presentation on the
computer before class begins limiting class interruption. The technician can
demonstrate how to use the equipment at the Dickson Center. If you are having
someone in the near-side help with your presentation, make sure you have
discussed the signal for forwarding the presentation. Send the presentation via
email and provide a disk to your helper to have a back-up in case either the disk
or emailed presentation fails.
Interactive Teaching Techniques
Here are some tips for encouraging interaction using different teaching techniques.
[ A D A P T E D FROM T WE L V E I NTE R A CT IVE T E C H N I Q U E S FOR
T E L E C O N F E R E N C I N G , U N I V E R S I T Y OF W I S C O N S I N , ( M O N S O N , 1 9 9 4 ) ]
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Technique

Tip

Lecture

Use only when presenting s great deal of material in a
short amount of time.
Delivery should be spontaneous and natural.
Pacing is extremely important.
Keep it short. 10-15 minutes
Alternate short segments with activities.
Preview-Present-Review!

Team Teaching

Share the teaching role with two (or more) individuals.
Adds versatility, usefulness, and convenience.
Team up experts who agree, disagree, or balance their
expertise
Plan class outline in advance.
Clarify Roles, time limits, and presentation
responsibilities.
Assign a ―leader‖ for each session.
Plan for feedback from the group.

Expert Guest

Augment curriculum with participation by experts.
Provide information about your students, class
objectives and class format to the guest.
Provide students biographical and other information
about the guest.
Act as a moderator to provide a link between the guest
and the students.

Interview

Add vocal variety and pacing to generate excitement.
Tailor the content to students’ needs by sending
questions before the program
Limit your interview to 20 min.
Keep the interview fast-paced.
Moderate the interview by making transitions,
clarifications, and summaries.

Panel Discussions

Explore ―hot topics‖ and encourage people to identify
with a view point.
Open the discussion with a question or statement that
introduces the central point of interest.
Have each speaker (not more then 4) begin the
discussion by giving a short (2-3 minute) opening
statement.
Moderate the discussion to provide the link between
the panel members and students, making transitions,
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drawing out comments, and summarizing the core
ideas.

Brainstorm Session

Explore a problem by pooling the ideas of the group.
Encourage spontaneity and stimulate creativity
Promote an atmosphere of support and openness.
Initially, accept all ideas, evaluate none.
Encourage students who don’t normally contribute to
become actively engaged.
Appoint a recorder at each site to jot down ideas and
synthesize comments.
Limit the session to 10-15 minutes.

Question & Answer

Use Q&A to provide the instructor or speaker with
feedback.
Shift the focus from speakers to the students.
Review and clarify the major points.
Allow time for the students to think, make decisions,
phrase questions, and synthesize the material.
Be encouraging and willing to wait - be prepared for
periods of silence.

Hands-on Activities

Encourage your students to be actively engaged in the
learning process
Build cooperation, rapport, and teamwork among
students.
Clarify the goals of group work sessions.
Provide a theoretical foundation or demonstration, and
then a description of practical applications.
Allow time for listening, questions and comments, and
coordination of group activity.
Assign follow-up work.

A Checklist for Preparing to Teach a Quality Videoconference Course

When preparing to teach a regular college or university course, faculty can assume that certain
things will be taken care of. Usually, the department will schedule the course, the registrar will
arrange for the room and list the course, the bookstore will order the required materials, and
students will register and show up on the first day of class.
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You, as professor, will have prepared your lecture notes and assignments, and made
sure that the proper supporting materials are available, either as handouts, in the library,
or, increasingly, on the campus computer network.

Ready, set, go. . . . . . . . . . . .
. . . . . . . .Well, not so fast.

If you are teaching via videoconferencing, there are other things that need to be
considered that may not yet fall within the range of responsibilities of academic support
services on campus. The campus infrastructure is designed for, and works well for,
traditional courses. But videoconferencing introduces new ways of teaching and
learning, and you cannot assume that the old procedures will be sufficient for your new
purposes. Furthermore, there are additional considerations for videoconference courses.

Some of the items on the following checklist are for others in your institution to attend to
so that you will have a quality course. But, at least initially, it is your responsibility to
shepherd the process through to be sure all bases are covered. At some institutions,
faculty will need to do everything on this list. At others, they will need only to monitor
that someone else has done them.
And remember, since you will be videoconferencing to one or more remote sites, all of
these details will have to be handled at every site.

What Faculty Need to Do
I.

Scheduling
Plan offerings with faculty, chairpersons, and deans
Monitor schedule changes and be sure all participants are notified.

II.

Registration
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Track enrollment and registration statistics.
III.

Preparing to Teach
Before classes begin, send a welcome letter to students at all sites,
including, admissions and records information, computer access and
library information (see model letter at the end of this chapter)
Explain your expectations and protocols on the course syllabus
Order books at all sites
Be sure library materials are available to students at all sites
Coordinate a "mail system" for distribution of materials
Provide fax numbers, websites, and e-mail addresses for distribution of
materials

IV.

The First Class
On the first day of class, articulate your expectations and protocols for
interactive teaching and learning
Introduce all students, at local and remote sites
Involve the students on camera immediately
Provide appropriate training to make the students comfortable with
the environment.

V.

Assessment and Evaluation
Conduct student evaluations
Conduct faculty evaluations
Conduct facilitator evaluations
Analyze and report data as appropriate
Make changes where necessary
Reevaluate.
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Creating Dynamic Presentations
“One of the Internet's inventors, Vint Cerf, gets laughs from audiences by quipping,
„Power corrupts and PowerPoint corrupts absolutely.”‟”
http://www.cnn.com/2003/TECH/ptech/12/30/byrne.powerpoint.ap/

any people disagree on the use of PowerPoint in the classroom. They argue that
PowerPoint takes the spontaneity out of classroom teaching and presents
information in a synopsized, linear fashion. PowerPoint presentations do not take
into account a student’s prior knowledge on the subject, his/her interests or
backgrounds. Further, the use of PowerPoint slides encourages students to be
passive absorbers of information as they watch and listen from slide to slide. Finally, some
believe that PowerPoint misleads students into thinking that all the information they need to
know is included in the PowerPoint presentation thus, when it is provided either before or after
a class on the Internet or as hand-outs in a class setting, that they do not need to pay attention
and sometimes, do not need to attend class. (http://www.ntlf.com/html/sf/notevil.htm)

M

In fact, when used properly, PowerPoint can be a valuable tool that enhances classroom
learning. Grash and Yangarber-Hicks found:
―A PowerPoint slide show aids students with a visual learning style to process
information better. It also provides visual novelty that our cognitive system needs
to help us pay attention for extended periods. And, by highlighting important
concepts, the slide show enables learners to capture important points easily. In
effect, a PowerPoint slide show has much more conceptual depth than one would
imagine.‖ (p.3).
PowerPoint provides a powerful platform to aid in your presentations. You can creatively
apply PowerPoint to numerous classroom applications, but it is most conducive to applications
such as delivering automated instructions in lab sessions, gathering outcomes of discussions
and conducting polls during class, providing tests and options for consideration during class
sessions, question and answer sessions, interacting with Web sites and information, self-study
sessions with feedback after the class activity, student presentations, building complex
animations, and incorporating question and reflection time into your presentation (Allan Jones,
―The Use and Abuse of PowerPoint in Teaching and Learning in the Life Sciences: A Personal
Overview‖).
As with all powerful tools, you will need to invest a certain amount of time learning how to use
PowerPoint properly in order to fully realize the potential and value of the program. You will
need a significant amount of time to construct your first draft of the PowerPoint presentation.
You must gather and organize your notes as well as be prepared to put the information
located mostly in your head in an outline form in PowerPoint. Fortunately, PowerPoint has a
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smaller learning curve than comparable software packages and you should be familiar with
the platform in a relatively short amount of time.
Once you have learned some of the basics of PowerPoint, you can easily use simple
commands to enhance your presentations. The ―b‖ and ―w‖ keys turn the screen white or
black so that students’ attention returns to the faculty member rather than remaining on the
slides.
When creating a presentation, be aware of the elements that differentiate a good presentation
from a poor presentation. Try to ensure that the presentation you are giving conforms to the
style of presentation that you would enjoy attending. PowerPoint provides great freedom for
the presenter, but is susceptible to many technological limitations which can be avoided when
the presentation is created.
Plan your presentation before you begin to build. This will expedite the creation process and
ensure that the presentation includes all of the information you intend to convey without
lengthy editing. Be sure to keep your presentations simple and include only necessary
information. PowerPoint provides a great platform on which to build during your presentation,
but becomes much less effective when you include every bit of pertinent information on every
slide. Use slides as outlines to frame your lecture or discussion not as a transcription of your
presentation. This will also keep your audience engaged as they cannot simply read along but
must pay attention and take appropriate notes.
Use only one animation. This is also important for continuity. Different, overt animations will
distract your audience from the content of the presentation. Limit yourself to two graphics per
page for the same reasons. Too many graphics become distracting and inhibit the audience’s
comprehension of your message.
Be consistent from slide to slide with graphics and format as well as with sentence structure
and verb tense. This will create continuity throughout your presentation that your audience
can easily follow. Use ―white‖ space on your slides to prevent your audience from paying
more attention to the slide than to you and the material you are presenting.
Standardize the position of elements. Again, this reinforces the consistency of your
presentation. By doing this, you ease the audience’s comprehension of your slides. Moving
important elements between slides confuses your audience and they spend time trying to find
important information on the slide rather than absorbing the information presented.
Create a presentation with a clear structure. Tell them what they are going to learn, teach
them, and tell them what they have learned. Limit your presentations to five key topics on 15
to 20 slides for every 50 minutes. This ensures that your audience is given ample time and
reinforcement for each of your primary points.
The slides are meant to provide an outline that supports the material that you will be
presenting. Remember: PowerPoint provides support for the presentation that you are giving.

36

Video Conferencing Manual

Employ the Rule of Thirds. Horizontally divide your slides into three equal sections. Title your
slides with brief attention getting headers in the top third, place your content in the middle third,
and leave the bottom third as empty as possible. This bottom third may contain a graphic or
page number, but should hold no information that may be vital to your presentation. Due to
sight lines, your audience may not be able to see the bottom third of your screen. Any
information contained in that portion of the slide will be obstructed by other audience
member’s heads or other obstacles. Use the Header and Footer option to insert repetitive
information that is not crucial to the audience’s comprehension.
Use bullets to separate your key points. This will draw attention to them and create a
distinction between each point and the remaining content of your slides.
Bullets are at their best when they: give the audience more substance than if they are just
listening to you; help guide the audience through your topics; show them the logical
progression of your ideas. More concise bullets are imaginative and effectively vague.
Speak at a normal pace. Just as in any other presentation, you must allow your audience time
to assimilate the information that you are providing. Hurrying your speech will confuse your
audience and inhibit their comprehension.
Avoid excessive use of color, animation, transitions, and sound. These elements provide
interesting additions to your presentation when used sparingly. If used in excess, they
become distracting and detract from the information you are trying to convey.
Remember whom you are trying to reach. Tailor your presentation to your intended audience.
PowerPoint eases this process for you as reworking slide content and order is very easy in this
platform.
Customize templates to suite your needs. Microsoft templates are notoriously poor and must
be altered to create effective and legible presentations. Templates that contain too many
elements must also be avoided. Remember to keep your presentation simple so as not to
distract your audience from the important information you are conveying.
Font and Color Choice:
Don’t use underlining unless it is for a link. This convention has been perpetuated across
many Internet pages and your audience will be anticipating its use in an electronic
presentation.
Digital fonts should be san-serifed. Non-digital fonts should be serifed. This describes the
manner in which the computer creating the presentations displays the characters and letters.
Sans-serif fonts will display more accurately at different screen resolutions.
Font size also matters. A good standard to remember is that for every 10 feet away from the
screen the furthest audience member is, the font should increase by ½ inch. The thickness of
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the font is also important. Thin line fonts are difficult to see while extremely bold fonts reduce
legibility. Moderate line fonts provide the most legible option. Do not rely on the outline
feature for your font choices. Your best results will come from experimentation as you
determine what is most legible to your audience. A good place to start with your fonts would
be: Main heading text = Arial font, 44 point font size and body of slide text = Arial font, 28 point
font size.
Do not use many different fonts on one page. Pick one for emphasis and one for text.
Remember the purpose of text is to communicate. If it is hard to read, your message won’t get
across. Remember to use the same weight (thickness) of text for each title or subheading.
Use all caps only for emphasis. This is very distracting and the electronic equivalent of yelling
at your audience. Also, in titles or headings, avoid capitalizing more than six words. This is
distracting as well and de-emphasizes your point.
Be sure that your line spacing is legible as well. 1.5 is best as it provides enough separation
between the lines of text that they remain legible at a distance.
Do not justify your type. This creates one solid, uniformly wide block of text and adds
unneeded spaces between words. This is very difficult to read and also de-emphasizes your
message.
Use a spell checker. Mistakes happen during the creation process and you may miss them in
any revisions you do as well. Simply double-checking your presentation’s spelling, grammar,
and syntax can easily avoid embarrassing errors.
Use two text colors only. Too many colors will not work well with whatever background color
you have decided to use. Multiple colors will become illegible or confusing. Avoid red and
green text as they can be very difficult for your viewers who have visual impairments
(Dyslexia, Color Blindness).
Choose harmonious color schemes. Analogous colors are adjacent to each other on the color
wheel below and are appropriate when used as background and text colors. Complementary
colors sit opposite each other on the color wheel. Complementary colors improve legibility and
ease the strain on the viewer’s eyes when they move between the different colors on each
page.
Do not use complementary colors for text and background. They vibrate making focus difficult.
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Use no more than five colors for charts and graphs. Too much color becomes distracting and
difficult to interpret from a distance. Remember that some members of your audience are
necessarily quite a distance from the screen and will have trouble discerning small elements in
the slides as well as fine color distinctions.
Four Design Principles:
Contrast:
The basic purpose is to emphasize your message and improve intelligibility. Create an
interesting page. Make sure that your pages provide some visual interest to your audience
beyond the simple statement of the information. You can achieve this by varying your fonts
and their styles as well as colors, sizes, shapes, and spacing.
This could be as simple as bulleted text under bold headers, but can be used to emphasize
certain points and logically progress through your topics. Simple visual cues can aid in the
organization of your information.

Be sure to avoid the issues we have discussed previously, but do try different layouts and
color choices to encourage your audience to remain engaged in your presentation.

Low

High

Contrast

Contrast
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Repetition:
Repeat some aspect of the design throughout the entire presentation to ensure visual
continuity between your slides. Bold header fonts, repeated headers or graphics, thick line,
bullets, consistent uses of color or design elements, spatial relationships between slide
elements, and format are just a few examples of easily repeated elements that can unify your
slides into a coherent and consistent presentation.
While repetition can add necessary continuity to your presentation, be sure that you do not
over-employ this technique. Too much repetition can actually dull your presentation. Each
slide must have some contrast to distinguish them from the other slides. Otherwise the
presentation becomes too repetitious and what may have initially been visually stimulating
becomes boring. Be conscious of the value of contrast.
Alignment:
Your slides should retain a similar layout throughout your presentation. This will easily unify
and organize your slides. Strong alignment creates a sophisticated, formal look.
Be conscious of where you place your slide elements. Chose a consistent point on your slides
which will provide an anchor for you to align the slides components. This will ensure the
presentation’s continuity and prevent jarring misalignments when switching between slides.
These can be distracting and difficult to follow.
Try to avoid multiple text alignments and especially centered text. This will guarantee that
your audience is not searching your slide for information rather than listening to the material
you are presenting. Align your text blocks to each other to preserve consistent visual format
throughout your slides.
Graphic elements should also be aligned with each other for the same reasons. The audience
will be drawn to elements that are misaligned. Nothing should be placed on the page
arbitrarily. Every item should have a visual connection with something else on the page in
order to create a stronger, more cohesive presentation.
Even if the items are separated, when aligned they create a symmetry that appeals to your
audience and encourages comprehension.
Proximity:
The physical relationships between your slides’ elements can help you organize and present
your information. The idea of proximity doesn’t mean that everything is closer together; it
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means elements that are intellectually connected, that have some sort of communication
relationship, should also be visually connected. The closeness or lack of closeness indicates
the relationship. Proximity creates instant visual clues for your audience and implies
relationships between different slide elements.
When items are in proximity to each other, they become one visual unit.
Be sure to limit each slide to a small number of separate elements to prevent the slides from
becoming cluttered and illegible. Placing too many objects in the corners of the page or
directly in the middle distracts the eye of the audience members and draws their attention
away from the information you are presenting. Avoid leaving equal amounts of white space
between elements unless each group is part of a subset. Avoid even a split second of
confusion over whether a headline etc. belongs with its related material. Avoid creating
relationships with elements that don’t belong together.
Color Symbolism:
Colors have symbolism and meanings and can sometimes create a physical reaction. Cool
colors such as blue and green are calming. Warm colors such as red, yellow, and orange
cause excitement. Colors like purple mix the properties of warm and cool colors since they
are derived by mixing cool and warm colors. Neutral colors such as brown, tan, beige, gray,
silver, black, and white are good for backgrounds.
Red is hot. A stimulant, it's the hottest of the warm colors. Studies show that red can have a
physical effect, increasing the rate of respiration and raising blood pressure. Use red to grab
attention and to get people to take action. Red is power. Use red when you don't want to sink
into the background. Use red to suggest speed combined with confidence and perhaps even
a dash of danger.
Pink is a softer, less violent red. Pink is the sweet side of red. Both colors denote love but
while red is hot passion, pink is romantic and charming. Use pink to convey playfulness (hot
pink flamingoes) and tenderness (pastel pinks).
Yellow is sunshine. It is a warm color that, like red, has conflicting symbolism. On the one
hand, it denotes happiness and joy, but on the other hand it’s the color of cowardice and
deceit. Use the color to lift spirits and project optimism. Because of the high visibility of bright
yellow, it is often used for hazard signs and some emergency vehicles. Use yellow to perk up
a more subdued palette of blues and grays. Use lemon yellow with orange to carry out a
healthy, summery, citrus theme.
A cousin to yellow (and orange and brown) is gold. While green may be the color of money
(U.S. money, that is) gold is the color of riches. Glittery gold denotes richness from money
while an earthy, orange gold can suggest more emotional riches from family and friends.
Orange is vibrant. As a warm color it is a stimulant inspiring the emotions and even the
appetite. It denotes energy, warmth, and the sun, but orange has a bit less intensity or
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aggression than red since it is calmed by the cheerfulness of yellow. If you want to get noticed
without screaming, consider orange — it demands attention. The softer oranges such as
peach are even friendlier. Orange brings up images of autumn leaves, pumpkins, and (in
combination with Black) Halloween. Orange is also a citrus color. It can conjure up thoughts of
vitamin C and good health and while orange is often synonymous with autumn; the brighter
oranges are a summer color. Orange is mentally stimulating as well as sociable. Use it to get
people thinking or to get them talking.
Blue is calming. Blue is a universal color. The cool, calming effect of blue makes time pass
more quickly and it can help you sleep. A deep royal blue or azure conveys richness and
perhaps even a touch of superiority. Navy blue is almost black. It conveys importance and
confidence without being somber or sinister, hence the blue power suit of the corporate world
and the blue uniforms of police officers. Long considered a 'corporate' color, blue is associated
with intelligence, stability, unity, and conservatism. Combine a light and dark blue to convey
trust and truthfulness — banker's colors. Mix blue with green for a natural, watery palette.
Lighter sky blue and robin's egg blue, especially when combined with neutral tans or beige are
environmentally friendly color combinations.
Green is life. Abundant in nature, green signifies growth, renewal, health, and environment.
On the flip side, green is jealousy or envy (green-eyed monster) and inexperience. Green is a
restful color. Time moves faster in a green room. With both a warming and cooling effect,
green denotes balance, harmony, and stability. Green with blue produces echoes of nature.
Green with tan or beige says 'organic' or 'recycled.' Green can convey quiet contemplation.
Green is associated with spring and (when combined with red) Christmas.
Teal, a mix of blue and green, is a bit livelier than either color alone. It carries a touch of
sophistication and richness.
Purple is royalty. A mysterious color, purple is associated with both nobility and spirituality.
Deep or bright purples suggest riches while lighter purples are more romantic and delicate.
Purple is associated with creativity and moodiness. A deep eggplant purple with neutral tans
or beige is an earthy, conservative color combination with a touch of the mystery that purple
provides. Purple has a special, almost sacred place in nature: lavender, orchid, lilac, and
violet flowers are often delicate and considered precious. Purple might suggest something
unique or extremely special, but with an air of mystery. This shade of purple suggests
refinement. Lavender may be a good choice when you are targeting women and want to
invoke feelings of nostalgia or romance.
Brown is a natural, down-to-earth neutral color. While brown conveys a wholesome
earthiness, its darkest and lightest shades from chocolate brown to pale beige and goldenbrown are rich, refined, and even elegant. It is a warm color that can stimulate the appetite.
Some of the positive attributes of brown are simplicity, friendliness, dependability, and health.
Brown and its lighter cousins in tan, taupe, beige, or cream make excellent backgrounds
helping accompanying colors appear richer, brighter. Shades of brown coupled with green are
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an especially earthy pair, often used to convey the concept of recycling or earth-friendly
products.
Beige, can take on some of the attributes of yellow or pink when touched with those shades.
Gray is a neutral, balanced color. It is a cool, conservative color that seldom evokes strong
emotion although it can be seen as a cloudy or moody color.
Dark, charcoal gray carries with it some of the strength and mystery of black. It is a
sophisticated color without some of the negative attributes of black.
Silver, especially shiny, metallic silver, is cool like gray, but livelier and more playful. Silver can
also denote riches just as gold does. Silver can be earthy, natural or sleek, and elegant.
Taupe, a grayish brown neutral is a conservative, slightly earthy color.
Gray and silver work well with other cool colors such as blue or teal.
Black and White are opposites that share the attribute of neutrality.
Considered the negation of color, black is conservative. It can be serious and conventional.
Black can also be mysterious, sexy, and sophisticated. Black is the ultimate dark color and
makes lighter colors such as yellow really pop out. Photographs often look brighter against a
black background.
White is purity, cleanliness, and innocence. Like black, white goes well with almost any color.
In most cases, white is seen as a neutral background color. To the human eye, white is a
brilliant color that can cause headaches for some. Too much white can be 'blinding.'
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Sympodium
Objectives

Upon completion of this tutorial you will be able to:

1.
2.
3.
4.
5.

use the Sympodium interactive screen
use the Sympodium Notebook Interface
edit objects in the notebook software
save, open, print, change the name, add and delete pages in the notebook software
use the Floating Toolbar with Excel, PowerPoint and Word.

 Use the Sympodium Interactive Screen.
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Adjust the angle of the screen by pressing the
button up and gently lifting the screen up or down.

1

2

4
3

5

1

2

4
3

1

2

3

Onscreen Display Control Buttons
1. Menu Button – shows the onscreen display
menu.
2. – and + Buttons – use these buttons to
select an option.
3. Enter Button – used to select a
highlighted item.
4. Power Button – turns on the screen.
Function Buttons
1. Right Click Button – used to activate the
right-click feature as if you were using a
mouse.
2. SMART Keyboard Button – activates the
keyboard.
3. Screen Capture Tools Button – activates
the screen capture tools.
4. Floating Toolbar Button– activates the
floating toolbar.
5. Notebook Button – activates the
Notebook Software.
Pen Tool Buttons
1. Black, Blue and Red Ink Buttons – used
to choose a color pen.
2. Left-Click Button – use this tool to select
options as you would the left-click button
on a mouse.
3. Eraser Button – erases the screen.
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 Use the Sympodium Notebook Interface.
Menu
Toolba
r
Standar
d
Toolbar
Interactive Screen
Slide
Sorter


Menu Toolbar Options
File
open new or existing files
save your file
export files in a variety of formats
print files or modify print settings






Edit
undo or redo previous actions
cut, copy, paste or delete selected
objects or all objects on the page
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View
change the current view
(Whiteboard, Page Sorter,
Attachments, Full Screen) or
toolbars
move between pages or zoom in or
out
launch the Screen Capture tool
use the Screen Shade· launch the
Gallery
Insert
add blank page(s), clip art,
templates or graphics files



Format
change font properties (type, size,
bold, italic), color, line width,
transparency, fill or background
color





Draw
create rectangles, ellipses, lines,
text and other shapes
select, reorder, group or ungroup
objects
access Pen or Highlighter tools
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Help



access a tutorial and information
about Notebook software
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Edit objects in the notebook software

Writing with the Pen Tool
1. From the Draw menu, select Pen.
2. Begin writing on the interface.

Changing Pen Attributes

1. Change Color – Format menu > Current
Color > Select color from palette.
2. Change Line Width - Format menu > Line
Width > Select a number.
3. Change Transparency – Format menu >
Transparency > Choose a percentage.

Using the Highlighter Tool
1. FROM THE DRAW MENU, SELECT,
HIGHLIGHTER.
2. BEGIN WRITING ON THE INTERFACE.
Changing Pen Attributes

1. Change Color – Format menu > Current Color >
Select color from palette.
2. CHANGE LINE WIDTH - FORMAT MENU >
LINE WIDTH > SELECT A NUMBER.
3. CHANGE TRANSPARENCY – FORMAT MENU
> TRANSPARENCY > CHOOSE A
PERCENTAGE.

Drawing Shapes
1. From the Draw menu, select Rectangle, Ellipse,
Line or Shape (a submenu appears > select
desired shape.
2. Using the pen tool press the tip on the interface
then drag the shape to the desired size.
Changing Shape Attributes

1. Change Color – Format menu > Current Color >
Select color from palette.
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2. CHANGE LINE WIDTH - FORMAT MENU >
LINE WIDTH > SELECT A NUMBER.
3. Change Transparency – Format menu >
Transparency > Choose a percentage.

Typing in Notebook Software

1. To type in the Notebook software, just begin to
type.
2. Finished typing – Press the Esc key on the
keyboard or click outside the text box on the
Notebook page.
3. Edit Text by double-clicking on the text.
Changing Type Attributes
1. FONT – FORMAT MENU > FONT (THE FONT
DIALOG BOX OPENS – CHOOSE THE
DESIRED OPTIONS.)

Editing Objects (Text and Shapes)

Select a Single Object

Click on the object.

Select Multiple Objects

Place the pen on the interactive screen and drag
the pen until all of the desired objects are
selected.

Select All Objects

From the Edit menu, click Select All.
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Move an Object

Select the object.
Drag the object to the desired location.
Move the object in small increments by using the
arrow keys on the keyboard.

Deleting and Erasing Objects

Select the eraser from the pen tray.
Drag the eraser using the pen over the object(s)
you want to delete.



Save, open, print, change the name, add and delete pages in the notebook software.

Open an existing File

File > Open

Open a New File

File > New



Save a File





File > Save

Print a file

File > Print

Change the Name of a Page

1. Click once in the Page Title box.
2. Enter the new title for the slide.
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Adding a New Page

Use the Next page button
located in
the standard toolbar to add a new page to
your file.
Use the previous and next buttons
to navigate within the file.

Deleting Page

1. In the Page Sorter, click on the thumbnail
of the page you want to delete.
2. From the edit menu, select Delete Page.

Use the Floating Toolbar with Excel, PowerPoint and Word.

Capture Annotation Made During a Demonstration

1. Open the SMART Board Tools toolbar by
clicking on the icon on the desktop.
2. Click on the words ―Floating Tools….‖The
floating toolbar will appear. It will appear on top
of all compatible programs such as Word,
Excel and PowerPoint.
3. Create annotations in your program.
4. Capture the annotations you make by choosing
the Camera icon in the Floating Toolbar.
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